
AppleTalk Remote Access Client

_____________________________________________________________________________
CHAPTER 1-GETTING STARTED
_____________________________________________________________________________

Before you can call another Macintosh or an AppleTalk network, you must
install the AppleTalk Remote Access Client software on your Macintosh
computer. You must also connect your computer to a modem. This chapter
provides software installation instructions and shows you how to indicate
your modem setup.

What you need to get started

To use AppleTalk Remote Access Client, your Macintosh computer must be
running system software version 7.0 or later and must have at least two
megabytes of random-access memory (RAM), although four megabytes are
recommended. You also need an appropriate Hayes-compatible modem with a data
rate of at least 2400 bits per second (bps). See Appendix A for more
information on which modems you can use with AppleTalk Remote Access Client.

Your AppleTalk Remote Access Client package includes:

- two 800K disks, titled AppleTalk Remote Access Client Installer Disk 1 and
Installer Disk 2

- this manual, the AppleTalk Remote Access Client User's Guide

The Installer disk (or disks) include the software and the Installer program
that you'll use to install AppleTalk Remote Access Client software on your
Macintosh.

Installing AppleTalk Remote Access Client on your computer

Follow the steps in this section to install the Remote Access Client software
on your computer.

1.  Insert the disk Installer Disk 1 into your floppy disk drive and double-
click the Installer icon to open the program.

Note  If you already have AppleTalk Remote Access installed on your
computer and you install AppleTalk Remote Access Client, your
Macintosh will no longer be able to answer calls, regardless of
whether it was set up to answer calls previously. 

2.  Select the disk where you want to install Remote Access Client, then
click Install.

The installation process begins. The Installer will prompt you to insert
Installer Disk 2 before continuing.

The Installer cannot install Remote Access Client software on your Macintosh
if any application programs are open. You'll see a dialog box if you have any
programs open, and you can choose to quit the open programs and continue the
installation process or you can choose to cancel the installation process.



If you have AppleTalk Remote Access already installed on your computer, the
following dialog box appears, warning you that AppleTalk Remote Access Client
Only will be installed and your Macintosh will no longer be able to answer
calls. If this is appropriate, click Continue.

When the Installer has finished, a dialog box appears to let you know that
the installation was successful.

3.  Click Restart to restart your computer.

Installation is now complete. The Remote Access icon appears on your hard
disk's directory, while other components of AppleTalk Remote Access Client
appear in your System Folder. Later, you'll use these other components to set
up connection information.

Indicating your modem setup

Before your Macintosh can make calls, you need to connect a modem to your
computer (a modem is a device that enables a computer to transmit data over
telephone lines). See Appendix A for a list of modems that you can use with
AppleTalk Remote Access Client, as well as what to do if your modem isn't
among those listed. Though you can use a modem capable of transmitting at
least 2400 bps, a 9600-bps or higher-speed modem is recommended.

The documentation that came with your modem will explain how to set up the
modem for use with your computer. Once you've properly connected the modem,
you need to register modem information with Remote Access Client. Follow the
steps in this section to indicate your modem setup to the AppleTalk Remote
Access Client software. You need to complete this procedure only once, after
you've connected the modem to your computer. Make sure you've already
installed the Remote Access Client software as described in the previous
section.

1.  Double-click the Remote Access icon to open the program.

!!  IMPORTANT  If AppleTalk is not specified as active in the Chooser, you
may see a message that AppleTalk Remote Access Client is not installed
correctly. Make sure the word "Active" next to the word "AppleTalk" is
selected in the Chooser.  !!

An untitled connection document appears. Ignore this for now, because it's
used to make calls to the server; you'll work with connection documents in
Chapter 2.

2.  From the Setup menu, choose Remote Access Setup.

The Remote Access Setup control panel opens. This is where you indicate your
modem setup.

Note  Another way to open the Remote Access Setup control panel is to
choose Control Panels from the Apple menu, then double-click the Remote
Access Setup control panel. 

3.  Choose your modem type from the Modem pop-up menu.

Press the Modem pop-up menu. Drag through the list and choose the name of
your modem. If your modem doesn't appear, refer to Appendix A for further



information.

4.  Choose the port to which your modem is connected from the Port pop-up
menu.

If you don't know which port your modem is connected to, look at the back of
your Macintosh. The port where the modem is connected has an icon above it,
which looks like the Modem or Printer port shown in the following figure.

You're now done indicating your modem setup to the AppleTalk Remote Access
Client software. You don't need to repeat these steps again unless you
connect another type of modem to your computer.

_____________________________________________________________________________
CHAPTER 2
_____________________________________________________________________________

CALLING WITH REMOTE ACCESS CLIENT 

After you've installed AppleTalk Remote Access Client software and connected
a modem to your computer, you need to do the following to make a call:

- Obtain the password your server administrator has assigned to you. Also,
check with the server administrator to verify how your name is indicated on
the server, so that you can enter matching information when you call.

- Obtain the telephone number of the modem connected to the server you want
to call.

- Create a connection document, following the instructions in this chapter.

Creating a connection document and connecting to a server

The information that AppleTalk Remote Access Client needs to connect to a
server is stored in a connection document. You can create and save multiple
connection documents needed to call different servers.

The following steps describe how to create a connection document and connect
to a server.

1.  If necessary, double-click the Remote Access icon to open the program.

A new untitled connection document appears on your screen when you open the
program. (If you're continuing from the previous chapter, you should have an
untitled connection document on your screen.) You can also create a new
untitled connection document by using the New command from the File menu.

2.  Click Guest or Registered User.

You can call the server as a guest or registered user. When you open a new
connection document, the Registered User button is selected automatically.
Connecting to the server as a registered user means that, for security
reasons, you have been assigned a user name and password to the server. Make
sure you obtain the correct password and user name from your network
administrator. If you're connecting as a guest, skip to step 5.



Note  To connect as a guest, the server you're calling must allow
guest access. Check with your network administrator to find out if you
can connect as a guest.

3.  Enter your user name in the Name text box, if necessary, and press Tab.

If the cursor is not in the Name text box, tab to it or click in the box to
place the cursor. Your user name must match the spelling that is registered
with the server you want to call, but capitalization doesn't matter.

If you've specified an owner name for file sharing, the owner name appears
automatically in the Name text box of the connection document. However, you
may need to change the name because it must match the name as it has been
registered on the server.

4.  Type your password in the Password text box and press Tab.

Type in your password exactly as registered with the server you want to call.
As you type, the characters appear as dots (�) to prevent someone else from
reading your password. You must match uppercase and lowercase letters
exactly.

Note  If you attempt a connection with an incorrect password, an error
message may appear and you can try to connect again. However, as a
security precaution, if you try to connect using an invalid password
seven times consecutively (this may vary depending on the type of
server you call), the server will revoke your ability to make a
connection. In this case, you'll need your connection privileges
reinstated on the server you're trying to call. Check with your
network administrator if you need your privileges reinstated.

5.  Type the phone number of the server you want to call.

Enter the number as if you were dialing directly. For example, if the server
is in area code 818 and its phone number is 555-1234, type:

1,818-555-1234

A comma in the phone number designates a pause. You can use dashes for
readability, but the program doesn't require them. Also, Remote Access Client
assumes you're dialing from a touch-tone phone. For information on pulse
dialing and commands interpreted by the modem, refer to the section "Modem
Commands" in Appendix A.

!!  IMPORTANT  The option "Save my password" lets you save your password
in the connection document. If you save your password, you won't need to
enter it whenever you connect. However, this compromises the security of the
server you're calling, because anyone can then use your connection document
to connect.  !!

6.  Click the "Remind me of my connection" checkbox if you want Remote Access
Client to remind you periodically that you are connected to a server. Then
type a number between 1 and 9999 in the "minutes" box.

The "Remind me of my connection" feature helps you avoid unintentional or
prolonged connections. After your computer is connected to a server for the
specified period of time, you will receive a message asking if you want to
continue your connection. If you click OK, your work will not be interrupted.



If you do not respond within one minute, AppleTalk Remote Access Client will
disconnect your computer from the server.

7.  Click Connect.

When you click Connect, AppleTalk Remote Access Client calls the server and
tries to connect to it. The Remote Access Status window appears, showing you
the progress of your connection. To cancel the connection attempt, click
Cancel.

When your computer attempts to connect to the server, the server verifies
your name and password, and the connection is then established.

Note  If the server has callback turned on, you are temporarily
disconnected from it while it attempts to call you back. Your phone
will ring and the modem will answer the call. Then, the connection is
reestablished.

If you plan on connecting to the server again, you can save the information
in the connection document, following the instructions in the section "Saving
Your Connection Document" later in this chapter. That way, to connect to the
server, you just need to double-click the connection document to open it,
then click Connect.

Selecting remote network services

AppleTalk Remote Access Client allows you simultaneous use of the services of
your local AppleTalk network as well as those of the network of the server
you've called. Once you've established a connection to a remote AppleTalk
network with Remote Access Client, you select network services in the Chooser
window or use other network products such as electronic mail, following the
same steps you would to use the service on your local network.

Note  If you want to connect to your own remote Macintosh computer after
calling the server, make sure that you've turned file sharing on for that
machine. For more information about file sharing, talk to your network
administrator or refer to your System 7 documentation. 

As an example, the following steps show how to print to a LaserWriter that's
on a remote AppleTalk network. Let's say you have not yet used Remote Access
Client to connect. Assuming your Macintosh has an AppleTalk network printer
such as a LaserWriter attached, the Chooser window shows you the local
services available to you:

Once you've called the server and established a connection with the remote
AppleTalk network, you'll also see the services available on the remote
network.

1.  If you haven't done so already, call a remote server and establish a
connection; then, choose the Chooser from the Apple menu.

The Chooser window displays the network services and AppleTalk zones that are
currently available to you. Notice the LaserWriters available from the remote
network:

2.  Select a LaserWriter as you normally would, then close the Chooser.



You can now print to the remote LaserWriter.

Saving your connection document

Saving your connection document means you won't need to reenter the
information when you next call the same server. You'll only need to open the
connection document and click Connect. To save the connection document follow
this step:

- From the File menu, choose Save As.

You can use the Save As or Save command, or click the connection document's
close box. You'll then be asked to enter a name for the connection document.
Pick a name that describes the server you're calling, like "Winnemucca
Office." The connection document icon will appear in the folder where it is
saved. You can store connection documents wherever you like on your hard
disk.

When you next want to connect to the server, you can find the connection
document icon in the folder where you saved the document.

Changing or deleting connection information

After you've saved a connection document, you can edit any of the information
you've entered.

1.  Double-click the connection document icon to open it.

2.  Edit any of the information.

3.  Choose Save from the File menu.

Other ways to connect to a server

Another way you can open the Remote Access Client program is to drag the
connection document onto the Remote Access icon.

This opens the Remote Access Client program and the connection document. You
then click the Connect button in the connection document window to call a
server.

As a shortcut, hold down the  key when double-clicking the connection
document or when dragging the connection document onto the Remote Access
icon. The program will then automatically try to connect using that
connection document.

Viewing your connection status

Whenever the Remote Access Client program is open, you can view your
connection status by looking at the Remote Access Status window. To open the
window, choose the Status command from the Windows menu.

The Remote Access Status window appears, showing details of your connection.



The Remote Access Status window tells you where you're connected and for how
long you've been connected. Also shown is the time remaining for your
connection. The time limit is set by the network administrator on the server
you've called, or you may have no time limit for your connection, indicated
by the word "Unlimited." You can click the close box to close the Remote
Access Status window.

Using the Activity Log

The Activity Log documents all Remote Access Client events. It keeps track of
when a Remote Access Client connection is attempted, established, or
disconnected. The Activity Log retains the 1000 most recent activities.

Follow these steps to view the Activity Log:

1.  Double-click the Remote Access icon to open the program, if necessary.

2.  From the Windows menu, choose Activity Log.

The Activity Log appears, displaying the current and most recent activity of
your Macintosh. The first column shows the date and time of the activity. The
second column displays the user name. The third column describes the
activity.

Copying, saving, and clearing the Activity Log

To save the Activity Log for your records, you can select the Activity Log
entries and copy them to the Clipboard. Click the entry or Shift-click the
range of entries you want to copy, or use Select All from the Edit menu, then
use the Copy command from the Edit menu.

The entries are copied to the Clipboard as tab-delimited text, so you can
paste this into a spreadsheet file. Use this spreadsheet file to save
multiple records of the Activity Log, to sort and search through the
information, or to print.

You can also save the Activity Log as a text file. To do this, choose Save As
from the File menu. You're then asked to enter a name for the text file,
which is saved on the disk you specify. By default, the text file is saved
under the name Log, followed by a range of dates that correspond to the
earliest and latest activities in the Activity Log. Use any word-processing
or spreadsheet program to view or edit the text file.

Should you wish to clear the Activity Log completely, choose Clear Log from
the Edit menu. A dialog box appears, asking you to confirm that you want to
clear the Activity Log. After you clear the Activity Log, those entries
cannot be recovered, so you should save the log before clearing it.

Using Remote Access efficiently

The following sections discuss how to use Remote Access efficiently.

Remember that you are using standard telephone lines to connect to a remote
network. Just as you are billed for your toll calls and long-distance calls,
you are also billed if you call a server outside your local calling area.



If the server you're calling has the callback option turned on, it
disconnects your call and immediately calls you back. The server then
originates the phone connection and becomes responsible for the charges.

The following guidelines can help keep your long-distance phone charges to a
minimum:

- Disconnect as soon as you no longer need to use the remote network.

- Do not open programs such as word processors, spreadsheets, and graphics
programs on the remote network. Because the program will run over telephone
lines, commands may take an extraordinarily long time to complete.

- Prepare files as much as possible before you make a connection.

- Use the option "Remind me of my connection." This keeps you from forgetting
about a connection, because you must indicate that you want to remain
connected (otherwise Remote Access Client terminates the connection).

- As soon as you finish using a file server volume, disconnect from the file
server.

- While you're using file server volumes, don't leave their windows open.
These windows are updated periodically causing unnecessary network traffic.

Selecting remote network services only

When AppleTalk Remote Access Client is installed, the Network control panel
contains an additional icon called Remote Only. You use the Network control
panel to select the type of network to which you want to connect locally. The
default is LocalTalk, which uses the printer port on your Macintosh to
connect to AppleTalk networks. You may also see other icons depending on your
network setup.

You might select Remote Only for two reasons:

1.  To turn off access to your local AppleTalk network (LocalTalk, EtherTalk,
or TokenTalk), so you see only the remote network when you make a Remote
Access connection.

Sometimes you can't locate a service on the remote network because a service
on your local network has the same address. This is similar to phone numbers,
for which two people in different area codes may have the same seven-digit
phone number. If you don't specify the area code and dial only the seven-
digit number, you call the person who is in the same area code as you.
Selecting Remote Only is like dialing the area code, meaning you call the
person outside your local area. When you select Remote Only, access to the
local network is shut off, ensuring that all services on the remote network
are accessible.

2.  To turn off LocalTalk to free up the printer port on your Macintosh for
other uses, such as printing to an ImageWriter or StyleWriter.

If you want to use your printer port for something other than LocalTalk,
maybe to print to a StyleWriter or ImageWriter, you need to select Remote
Only. This shuts off access to the local network, leaving the printer port
free for another use. Since Remote Access is a type of AppleTalk connection,



making AppleTalk inactive in the Chooser means you can't use Remote Access.
So if you want to use Remote Access and the printer port, you need to select
Remote Only.

Be aware that if your Macintosh is currently connected to a remote network
and you switch from one AppleTalk connection type to another in the Network
control panel, such as from LocalTalk or EtherTalk to Remote Only, you will
be disconnected. However, you can always reconnect.

Disconnecting from the remote server

Once you establish a connection with a remote network, the Remote Access
Status window displays a Disconnect button.

1.  From the Windows menu, choose Status.

2.  Click Disconnect.

When you click Disconnect, the connection between your computer and the
server is broken. However, the Remote Access Client program is still open, so
you can make another connection or create a new connection document.

If for some reason you shut down your Macintosh while connected to a remote
network, the connection is automatically broken.

Quitting the Remote Access Client program

You can quit the Remote Access Client program at any time. Quitting the
program frees up memory for your computer to use for other processing. You
cannot quit if you're in the process of connecting or disconnecting.

To quit the Remote Access Client program, you need to do the following:

- From the File menu, choose Quit.

If you're currently connected to a remote network, your connection remains
active because quitting the program has no effect on the connection. If you
do quit while you're connected to a remote network, you see a dialog box that
reminds you of your connection. You must choose to disconnect and quit, stay
connected and quit, or cancel.

Remember that you'll need to reopen the program if you want to disconnect,
open a connection document, or check your connection status in the Remote
Access Status window. If you reopen the program while a connection is active,
the Remote Access Status window automatically opens.

_____________________________________________________________________________
APPENDIX A
_____________________________________________________________________________

USING MODEMS WITH APPLETALK REMOTE ACCESS CLIENT

AppleTalk Remote Access Client includes scripts (programs that can run
automatically) that make it possible for you to use many popular Hayes-



compatible modems. Hayes Microcomputer Products, a major manufacturer of
modems, developed a language for controlling modems that has been widely
adopted. Any modem that recognizes Hayes modem language commands is said to
be Hayes-compatible.

This appendix lists the modems that have scripts included with the AppleTalk
Remote Access Client software and discusses what you can do if your modem is
not included. This appendix also shows how to connect a typical modem to your
Macintosh and lists standard modem commands.

Modems you can use with Remote Access Client

AppleTalk Remote Access Client includes scripts for the following modems for
use within the United States. If you're using AppleTalk Remote Access Client
outside of the United States, contact your authorized Apple reseller or
representative for modem information. For the best performance of AppleTalk
Remote Access Client, Apple suggests you use a 9600-bps or higher-speed
modem.

2400 bps/V.22bis modems

- Apple Modem 2400 (supports all 2400-bps Apple modems)

- Abaton InterFax 24/96

- Global Village Teleport ADB

- Hayes SmartModem 2400

- Microcom MicroPorte 1042

- Practical Peripherals 2400SA

- Prometheus ProModem 2400

- Supra SupraModem 2400

- US Robotics Courier 2400e 

9600 bps/V.32 and 14,400 bps/V.32bis modems

- DSI 9624 LE/LE Plus

- Hayes Ultra 96

- Farallon Remote V.32

- Microcom MacModem V.32

- MultiTech MultiModem V32

- Practical Peripherals 9600SA

- Prometheus ProModem Plus/Ultima

- Telebit T1600



- US Robotics Courier V.32bis

For every type of modem that Remote Access Client supports, a script resides
in the Extensions folder within your System Folder. Modem scripts contain
program code used by the Remote Access Client software to communicate with
that particular modem type.

If your modem is not included

Your modem should conform to the CCITT (Comit Consultatif International
Tlgraphique et Tlphonique) standards V.22bis, V.32, or V.32bis. If you want
to use Remote Access Client with a modem not listed in the previous sections,
a script may be available for your modem. Check with one of the following
sources to see if a modem script is available:

- your modem vendor

- your authorized Apple reseller or representative

- the Apple Customer Assistance Center (800-776-2333 in the U.S.)

- if you're a subscriber, the Apple Technical Coordinator Answerline or the
Apple Software Development Answerline

Some modems not included with the Remote Access Client software may need a
cable that supports clear-to-send (CTS). Call the Apple Customer Assistance
Center for more information.

Writing modem scripts

If you understand connection control languages (CCLs) and are an experienced
programmer, you may be able to write the necessary modem script yourself. The
AppleTalk Remote Access Modem Toolkit is available through APDA (Apple
Programmers and Developers Association). The kit includes a HyperCard stack
and appropriate documentation to help you build scripts.

APDA offers convenient worldwide access to over 300 Apple and third-party
development tools, resources, and information for anyone interested in
developing applications on Apple platforms. To order products or get
additional information contact:

APDA
Apple Computer, Inc.
P.O. Box 319
Buffalo, NY  14207-0319
800-282-2732 (United States)
800-637-0029 (Canada)

716-871-6555 (International)

Fax: 716-871-6511
AppleLink: APDA
America Online: APDA
CompuServe: 76666,2405
Internet: APDA@applelink.apple.com



Connecting your modem

How you set up your modem depends on the type of modem you're using. The
documentation that came with your modem should provide specific details on
how to connect your modem to your computer. Depending on the type of modem or
Macintosh you use, you'll need to do the following:

- Connect your modem to your telephone line.

- Connect your modem to your telephone (optional).

- Connect your modem to your Macintosh.

- Connect a power supply to your modem.

The following picture offers a typical example that shows an Apple Data Modem
connected to a Macintosh:

Modem commands

Standard commands are interpreted by most modems available in the United
States. You enter these commands as characters in the telephone number sent
to the modem. The following table lists standard commands, but you should
refer to your modem manual for a complete description of the commands it
interprets.

Command

(character)     Function

0-9, #, *       Digits and characters used for dialing.

T               Causes all digits following to be touch-tone dialed (the
default).

P               Causes all digits following to be pulse dialed.

,               Pauses before continuing.

Pulse dialing

AppleTalk Remote Access assumes you're dialing from a touch-tone phone. If
you require pulse dialing, precede the number with a P, as shown here:

P1,818-555-1234

If you need a combination of pulse and touch-tone, precede the numbers with P
(for pulse) and T (for touch-tone) as appropriate. You may need to do this if
you're making a long-distance call with pulse dialing, and you first connect
to your long-distance carrier's lines then enter an access code using touch-
tone. In this case, the phone number you enter should look something like
this:

P1,818-555-1234 T342



_____________________________________________________________________________
APPENDIX B
_____________________________________________________________________________

While using AppleTalk Remote Access Client, you may occasionally encounter a
problem. This appendix provides information that is common to most modems and
offers suggestions for solving problems.

You can't make a call.

- Make sure your modem is connected properly and turned on. Refer to your
modem documentation if you have any problems.

- Make sure your modem type and port are selected in the Remote Access Setup
control panel.

Your modem is working, but you can't connect to the server.

- Check that you've entered your user name and password correctly.

- Find out if the server is set up to call you back, and verify that your
telephone number is correct.

- Make sure the server and its modem are turned on, and the server is set up
to answer calls.

You are losing the connection.

- You may have noisy phone lines. Contact your phone company.

- Make sure you've selected the correct modem type in the Remote Access Setup
control panel.

- The call-waiting feature can disrupt the connection when someone tries to
call you. When you enter the phone number in the connection document,
precede the number with the code to turn off call waiting. However, if the
server has callback turned on, your modem first hangs up, which reenables
call waiting. Contact your phone company for information on how to turn off
call waiting.

The response time from the remote network is slow.

- Make sure the Macintosh you've called is using at least a 9600-bps modem.
Look in the Activity Log to check the speed the two modems are using.

- Refer to the section "Connecting Efficiently" in Chapter 2 to see if you
can save time during the connection.

After you connect to a remote network, you have problems with your
ImageWriter or another device connected to the printer port.

- Change your network connection from LocalTalk (or EtherTalk or TokenTalk)
to Remote Only in the Network control panel to redirect AppleTalk and allow



you to print to your serial printer. Refer to the section "Selecting Remote
Network Services Only" in Chapter 2 for more information.

After you connect to a remote network, you cannot access your local network.

- Change your network connection from Remote Only to LocalTalk (or EtherTalk
or TokenTalk) in the Network control panel to access your local network.
Refer to the section "Selecting Remote Network Services Only" in Chapter 2
for more information.

Other programs that use the serial port don't function properly, you see a
dialog box that says the serial port is in use, or your Macintosh freezes
during shutdown.

- Remove the Serial Port Arbitrator from the Extensions folder in the System
Folder and restart your computer.

- If another program is incompatible with Remote Access Client, contact your
authorized Apple reseller for more information.


